MapXtreme 2005 v6.7
Release Notes

These Release Notes provide information on enhancements and updates made to MapXtreme 2005 v6.7. It also covers bug fixes, known issues, and other information that was not available at the time the Developer Guide went to press.

This document is a supplement to the MapXtreme 2005 Developer Guide. Refer to this document for release specific information and to the Developer Guide for overall product information and usage. The Developer Guide is available in three formats and from several locations, including:

• Printed guide included in the MapXtreme 2005 product box
• HTML version integrated into Visual Studio .NET 2003 and Visual Studio 2005 (in the Help Contents pane)
• PDF version accessible from the Start > All Programs menu under MapInfo > MapXtreme 2005 6.7 > Learning Resources browser
• PDF version on the MapInfo website at http://extranet.mapinfo.com/support/documentation/manuals.cfm#mapxtreme0405

List of Topics:

• What's New ................................................................. 2
• What's Changed ..................................................... 22
• Bug Fixes ................................................................. 24
• Known Issues .......................................................... 31
• Documentation Topics ............................................. 42
What’s New

MapXtreme 2005 offers the following new features in version 6.7:

- AJAX Sample Web Application
- Cartographic Enhancements
- Coordinate System Enhancements
- Export Formats
- Graticule Layers
- IIS 7.0 on Windows Vista
- LegendControl
- Performance Enhancements
- Supported Operating Systems, Databases, and Browsers
- Theme Performance and Usability Enhancements
- Workspace Manager Usability Enhancements

AJAX Sample Web Application

A new ASP.NET AJAX application sample has been added in this release of MapXtreme 2005. The AJAXDemo sample application demonstrates how to use Microsoft’s ASP.NET AJAX controls in a MapXtreme 2005 web mapping application. The sample is located in ..\MapInfo\MapXtreme\6.x\Samples\VisualStudio2005\Web\Features.

See Chapter 5: Web Applications, Controls, and Tools in the Developer Guide for more information on ASP.NET AJAX technology and MapXtreme web applications.

Note: The AJAXDemo sample requires that the Microsoft ASP.NET 2.0 AJAX Extensions 1.0 be installed on your system. These are available on the MapXtreme 2005 product CD.

Cartographic Enhancements

Enhanced Rendering with GDI+ Translucency and Anti-Aliasing

Microsoft Windows GDI+ is the portion of the Windows XP operating system or Windows Server 2003 operating system that provides two-dimensional vector graphics, imaging, and typography. GDI+ improves on Windows Graphics Device Interface (GDI, the graphics device interface included with earlier versions of Windows) by adding new features and optimizing existing features. GDI+ rendering in MapXtreme 2005 allows you to create translucent labels, themes, and layers, as well as apply anti-aliasing that will smooth the jagged edges of lines, curves, and region borders when representing a high-definition rendition at a lower resolution.
You can enable GDI+ rendering in the API through two new properties—EnableTranslucency and SmoothingMode—in the MapInfo.Mapping.DrawingAttributes and MapInfo.Mapping.LegendDrawingAttributes classes. You can also enable these properties using the new Style tab in Workspace Manager’s Layer Control.

**Note:** Anti-aliasing can only be used when translucency is enabled. This is enforced both by the user interface via the Workspace Manager and programmatically. When you select Use Anti-Aliasing, Enable Translucency is also selected automatically. Whenever Enable Translucency is deselected, Use Anti-Aliasing is automatically deselected.

The following maps demonstrate label translucency and anti-aliasing effects on roads and highways. Notice the smoothness of the region borders and polylines when anti-aliasing is enabled.

Before GDI+ Enhanced Rendering:  
After GDI+ Enhanced Rendering:
A translucency trackbar (TrackBarValuePicker control) was also added for use with all style dialogs (Line Style, Area Style, Symbol Style, Text Style, etc.). This control allows you to pick a percent value between 0-100 using the sliding trackbar or the numeric selection box. However, this trackbar only works when translucency is enabled.

To programmatically change a color’s translucency, use the System.Drawing.Color.FromArgb() method. This allows you to specify an alpha value for the desired color (in GDI+, the alpha channel is the portion of pixel color data reserved for transparency information). For more information, see the .NET documentation at http://msdn2.microsoft.com/en-us/library/system.drawing.color.fromargb.aspx.

Translucency in all colors is supported and tools will work properly when translucency is enabled or disabled. The Enable Translucency option has no effect on the display or export of translucent raster images, although it must be enabled to print them (see Translucent Printing on page 22).

Note: Rendering higher quality maps by enabling translucency and anti-aliasing, particularly in a map with three or more transparent layers, will often result in a slower rendering speed.
Adding Translucency Using Workspace Manager

How to Add Translucent Effects to a Map

The following map contains a translucent city boundary region. The partial overlap of this region over the “Watervliet” label shows the difference between the uncovered part of the label (the first two letters of “Watervliet”) and the covered part of the label. The label itself is also translucent over the rest of the map.

To add translucent effects to a layer, use a style override to change the original style of the layer.

**Note:** When you programmatically superimpose an override style modifier (OverrideType = AddNew), the first style drawn is the feature’s style. Since the superimposed style is translucent, the features show through it.

1. In Workspace Manager’s Layer Control, select the "root" node in the layer control (this corresponds to the map). In the Style tab select **Enable Translucency**.

2. Select the layer you want to add translucency to, move it to the top of the list, then add a style override.

3. On the Visibility tab for the style override, click the style button that is specific to the objects in that layer. For this example click the **Area style** button.
What's New

The Area Style dialog appears.

4. Use the translucency trackbar to select the level of translucency you want to apply. Each color has its own translucency level.

The previous example also showed a translucent label similar to a watermark. If you turn off visibility on the translucent city boundary region, the label looks as follows:

If you want to add a translucent label over your map as shown by this example:

1. In Workspace Manager’s Layer Control, select the "root" node in the layer control (this corresponds to the map). In the Style tab select **Enable Translucency**.
2. Select the label source in the layer control and go to the Style tab.
3. Click the **Text style** button to display the Text Style dialog.
4. Use the translucency trackbar to select how translucent you want your label color to be. The above example shows text at 80% foreground translucency.
What's New

How to Apply Translucent Effects to Themes

You can apply translucent effects to thematic maps. The following example shows a ranged theme applied to a city boundary layer. The layer is positioned on top of the rest of the layers.

If translucency is enabled, you can select a translucent value for the start and end theme ranges (bins), and automatically spread the color. This will also automatically spread the translucent value between the start and end theme bins. For example, the theme in the above map has a translucency value of 75% for the start bin (gray) and 50% for the end bin (red). Since this theme has 3 bins, the middle bin is automatically given a translucency value of 63% (50 through 75 spread equally).

Adding Translucency Using the API

How to Add Translucency to a Layer

The following C# code sample demonstrates how to add translucency to a layer programmatically via the API.

```csharp
// Load a map from a workspace:
Map map = Session.Current.MapFactory.CreateEmptyMap(new Size(500, 500));
MapWorkspaceLoader mapLoader = new MapWorkspaceLoader("Workspace.mws");
mapLoader.AutoPosition = false;
map.Load(mapLoader);

// Enable translucency and anti-aliasing:
map.DrawingAttributes.EnableTranslucency = true;

// Create a feature override style modifier to modify the area style foreground color of a layer with 50% translucency:
CompositeStyle style = new CompositeStyle();
((SimpleInterior)style.AreaStyle.Interior).ForeColor = Color.FromArgb((int)(255 * 0.5), Color.Red);
FeatureOverrideStyleModifier modifier = new FeatureOverrideStyleModifier();
modifier.Style = style;
FeatureLayer layer = map.Layers["LayerAlias"] as FeatureLayer;
```
What's New

layer.Modifiers.Append(modifier);

// We then export the map image to a bitmap:
using (MapExport mapExport = new MapExport(map))
{
    mapExport.Border = ExportBorder.Off;
    mapExport.Format = ExportFormat.WindowsBmp;
    mapExport.Export("ModifierExport.bmp");
}

Note: When you programmatically superimpose an override style modifier (OverrideType = AddNew), the first style drawn is the feature's style. Since the superimposed style is translucent, the features show through it.

How to Create a Translucent Ranged Theme

The following C# code sample demonstrates how to create a translucent ranged theme programmatically via the API.

// Load a map from a workspace:
Map map = Session.Current.MapFactory.CreateEmptyMap(new Size(500, 500));
MapWorkSpaceLoader mapLoader = new MapWorkSpaceLoader("Workspace.mws");
mapLoader.AutoPosition = false;
map.Load(mapLoader);

// Enable translucency and anti-aliasing:
map.DrawingAttributes.EnableTranslucency = true;

// Create a ranged theme with 7 bins from a feature layer:
FeatureLayer layer = map.Layers["LayerAlias"] as FeatureLayer;
RangedTheme rangedTheme = new RangedTheme(layer, "ColumnName", "RangedTheme", 7,
DistributionMethod.StandardDeviation);

// This theme only spreads by and applies color:
rangedTheme.SpreadBy = SpreadByPart.Color;
rangedTheme.ApplyStylePart = StylePart.Color;
// Since we are spreading by color, we can also spread the translucency of each bin
// color. We spread between 25% and 75% translucency. Translucency is expressed as alpha
// in .NET color struct. Alpha is a range between 0 and 255 which describes the opacity
// of the color. Opacity is the inverse of translucency. We will start with 25% opaque
// (which is 75% translucent) and end with 75% opaque (which is equivalent to 25%
// translucent):
int startAlpha = (int)(255 * 0.25);
int endAlpha = (int)(255 * 0.75);

// Modify the area style of the first and last theme bins to use a color from red to
// blue with the opacity values specified above. Since this theme is set to spread by
// color, the color range will spread using the start and end bin colors. The opacity
// will also automatically spread using the start and end bin opacity values:
rangedTheme.Bins[0].Style.AreaStyle = new AreaStyle(new SimpleLineStyle(), new
SimpleInterior(2, Color.FromArgb(startAlpha, Color.Red)));
rangedTheme.Bins[rangedTheme.Bins.Count - 1].Style.AreaStyle = new AreaStyle(new
SimpleLineStyle(), new SimpleInterior(2, Color.FromArgb(endAlpha, Color.Blue)));

// We will also use an inflection color at and use an opacity of 50% for that color:
rangedTheme.Inflected = true;
rangedTheme.InflectionIndex = 3;
int inflectionAlpha = (int)(255 * 0.50);
rangedTheme.InflectionColor = Color.FromArgb(inflectionAlpha, Color.Yellow);

// We then recompute and add the bin to the layer in the map:
rangedTheme.Recompute();
layer.Modifiers.Append(rangedTheme);

// We then export the map image to a bitmap:
using (MapExport mapExport = new MapExport(map))
{
    mapExport.Border = ExportBorder.Off;
    mapExport.Format = ExportFormat.WindowsBmp;
    mapExport.Export("RangedThemeExport.bmp");
}
### How to Create Translucent Labels

The following C# code sample demonstrates how to make translucent labels programmatically via the API.

```csharp
// Load a map from a workspace:
Map map = Session.Current.MapFactory.CreateEmptyMap(new Size(500, 500));
MapWorkSpaceLoader mapLoader = new MapWorkSpaceLoader("Workspace.mws");
mapLoader.AutoPosition = false;
map.Load(mapLoader);

// Create an override label modifier to modify the font foreground color of a label
// source with 50% translucency:
TextStyle style = new TextStyle();
style.Font.ForeColor = Color.FromArgb((int)(255 * 0.5), Color.Black);
style.Font.Attributes = StyleAttributes.FontAttributes.ForeColor;

OverrideLabelModifier modifier = new OverrideLabelModifier();
modifier.Properties.Style = style;
modifier.Properties.Attributes = LabelAttribute.Style;

LabelLayer labelLayer = map.Layers["LabelLayerAlias"] as LabelLayer;
LabelSource labelSource = labelLayer.Sources["LabelSourceAlias"];
labelSource.Modifiers.Append(modifier);

// We then export the map image to a bitmap:
using (MapExport mapExport = new MapExport(map))
{
    mapExport.Border = ExportBorder.Off;
    mapExport.Format = ExportFormat.WindowsBmp;
    mapExport.Export("LabelExport.bmp");
}
```
Curved Label Enhancements

The rendering of curved labels (arc and polyline labels that follow the curve of the line, such as streets and rivers) has been improved in this release of MapXtreme 2005. Curved labels are generated in the Workspace Manager by selecting the label layer, then selecting Parallel to Multiple Segments in the Position tab. See Chapter 22: Workspace Manager in the Developer Guide for more detailed instructions and the ILayout Interface section of the MapXtreme 2005 v.6.7 Developer Reference for information on rendering curved labels via the API.

Before enhanced curved labeling:

![Before enhanced curved labeling](image1)

After enhanced curved labeling:

![After enhanced curved labeling](image2)

This feature is made up of complex algorithms that are designed to enhance the display of your arc and polyline features. MapXtreme 2005 attempts to create a curved label for every arc and polyline record in a map, just as it does for non-curved labels. For example, in street maps, the street can be made of several polylines or one long polyline. The length and number of the polylines, the rules that govern whether a curved label can be created, and the labeling options you choose, all affect which curved labels are created and where they display.

Some polyline and arc segments in your layer data may not contain label name entries. When this occurs, MapXtreme 2005 cannot display labels for that segment.

Several rules determine whether MapXtreme 2005 can display a curved label:

- MapXtreme 2005 can only draw curved labels using TrueType fonts. If you select a non-TrueType font, a comparable TrueType font is substituted and the label you chose may display differently than expected. Also, if you change a horizontal label using a non-TrueType to a curved label, the new label may display differently due to the font substitution.
- Part of the label string must fit along the arc or polyline that it is labeling. If it cannot fit, MapXtreme 2005 determines that the label is too long and discards it.
- MapXtreme 2005 cannot draw curved labels for polylines that are very jagged, however, it depends on the curvature of the line.
- Although a street segment appears to be straight, the label may be curved. This happens because the polyline data for the street segment contains a curve that is not visible at the current zoom level. The label is following the curve of the street even though the curve isn’t visible. If you zoom in on the map to a close enough distance, you will be able to see the curve in the street.
- Labels that curve onto themselves are discarded and do not display.
- Curved labels follow the same rules for overlap detection, duplicate text, and partial segment labeling as non-curved labels. Each of these rules affect how and when the labels are displayed.
- You can create curved labels with the Label tool at any point along an arc or polyline.
- You cannot drag curved labels as you can other labels; however, you can reposition them with the Label tool.
- The Label Lines controls are disabled for curved labels.
- Curved and non-curved labels persist for layers in the workspace.
- You cannot underline curved labels.
- Curved labels are always drawn smoothly whether or not translucency and anti-aliasing are enabled.
Coordinate System Enhancements

New Coordinate Systems
This release includes support for three additional coordinates systems along with EPSG codes for each.

For a full list of coordinate systems, see the MapInfoCoordinateSystemSet.xml located in ..\Common
Files\MapInfo\MapXtreme\6.x, where 6.x is the release version of MapXtreme 2005.

The following coordinate systems are supported beginning with this release of MapXtreme 2005.

Hong Kong Coordinate Systems:
- Hong Kong 1980 Grid System

Luxembourg (International 1924) Coordinate Systems:
- Luxembourg 1930 / Gauss

Swedish Coordinate Systems:
- ST 74

S-JTSK (KROVAK) Coordinate System
- Added a new S-JTSK projection to serve the Czech Republic and Slovakia.

New EPSG Codes
The following EPSG codes have also been added for these coordinate systems:
- EPSG:2169 alias for Luxembourg 1930 / Gauss
- EPSG:2326 alias for the Hong Kong 1980 Grid System
- EPSG:3152 alias for ST 74

Dynamically Add EPSG Codes
We have added two ways for users to register EPSG or SRID codes that are not currently supported by MapXtreme:
- programmatically via the MapInfo.Geometry.CoordSysFactory class, or
- by adding code mapping elements to your application’s configuration file.

EPSG codes represent a collection of coordinate systems (known as codespaces) maintained in the EPSG Geodetic Parameter Dataset under the auspices of the International Association of Oil & Gas Producers (OPG). SRID codes are unique spatial reference numbers that refer to codespaces for Oracle Spatial tables.

The MapInfo.Geometry.CoordSysFactory class contains two new methods for registering EPSG and SRID codes. Each take two parameters: one is the EPSG or SRID code that represents the codespace, the second is the coordinate system information that EPSG or SRID code will map to. Note that this will dynamically register these codes, but will only last as long as the session.

For a permanent way to register EPSG and SRID codes, you must add new EPSG and SRID code mapping elements to your application’s configuration file.

For more information, see Chapter 15: Spatial Objects and Coordinate Systems in the Developer Guide.

Export Formats
You can now choose which API to use for exporting images, either .NET or LEADTOOLS. The MapExport and LegendExport classes can now export BMP, GIF, JPG, PNG, and TIF files using the .NET framework API.

In some cases, it is significantly faster to export using the .NET framework. While exporting may be faster using the .NET API, the quality of the exported images remains the same.
To support this new functionality, five new export formats were added to the ExportFormat enumeration—WindowsBmp, WindowsGif, WindowsJpeg, WindowsPng, and WindowsTiff. In Visual Studio’s designer property window, the five new image format types appear in the drop-down list in the ExportFormat property when the MapControl is selected.

For more information on export formats, see Chapter 13: Adding Mapping Capability to Your Applications in the Developer Guide.

Graticule Layers

Graticule layers were added in this release of MapXtreme 2005.

Graticules are grids (lines of latitude and longitude) that overlay the map, spaced at a regular distance (for example, every five degrees, every fifteen degrees). They are used to establish a frame of reference.

In many ways, graticules behave just like other layers. However, a graticule layer differs from other layer types in the following ways:

- Graticule layers are not editable like other types of layers. That is, you cannot add new features to it.
- Although you can configure graticule label style and position, you cannot create a label layer on a graticule layer.
- You cannot create a thematic layer on a graticule layer.
Adding Graticule Layers

You can add graticules directly from the Layer Control (right-click on the map node to access the context menu):

By default, the graticule spacing and extents are determined based on the zoom and size of the map window. So when you add a graticule layer to a map, graticule lines appear regardless of the zoom level.

Managing Graticule Layers

After you have added a graticule layer, you can manage and customize the layer from the Layer Control in a number of ways.

- Control graticule layer visibility and zoom/scale settings
- Show and configure spacing of major and minor graticule lines
- Control visibility and style of graticule labels and lines
- Specify the extents (in degrees, feet, or meters) of the graticule (east, west, north, south).
- Move the layers up and down in the Layer Control order
- Remove the graticule layer (the context menu is the only way to remove a graticule layer)
- Create multiple graticule layers and Group Layers

Graticule layers are indicated by a graticule icon, as shown below:
### Graticule Layer Settings

Layer Control allows you to control the appearance and style of graticule layers. When you click on a Graticule Layer, the following tabs are available at the bottom of the Layer Control.

#### Layer Control Tabs for Graticule Layer

<table>
<thead>
<tr>
<th>Graticule Layer Tab</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visibility</td>
<td>Controls the visibility of the layer and the zoom range or scale within which the selected layer displays.</td>
</tr>
</tbody>
</table>

![Visibility Tab](image1)

<table>
<thead>
<tr>
<th>Line/Label Properties</th>
<th>Controls the visibility, styles, and labeling of major and minor lines of latitude and longitude.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="image2" alt="Line/Label Properties Tab" /></td>
</tr>
</tbody>
</table>

![Line/Label Properties Tab](image2)
What's New

Layer Control Tabs for Graticule Layer (continued)

<table>
<thead>
<tr>
<th>Graticule Layer Tab</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Spacing</td>
<td>Controls automatic or custom spacing (intervals) of major and minor lines of latitude and longitude. Custom intervals can be in degrees (default), feet, or meters.</td>
</tr>
<tr>
<td>Extents</td>
<td>Allows you to control the range of latitude and longitude (north, south, east, and west) over which the graticule lines extend. The selections on this tab are enabled only if Custom is selected on the Line Spacing tab. After making any changes in this tab, click Set Extents to activate the changes.</td>
</tr>
</tbody>
</table>

IIS 7.0 on Windows Vista

Microsoft Internet Information Services 7.0 is included (although not necessarily installed) with Windows Vista. If the IIS 7.0 feature is installed on Vista, you must do the following to ensure a successful installation of MapXtreme 2005:

- Enable Windows Authentication and Anonymous Authentication.
- Enable the IIS 6 Metabase and IIS 6 Configuration Compatibility web management tools.

Note: For more detailed instructions, see Chapter 2: Getting Started in the Developer Guide.

To develop web applications in Visual Studio 2005 on Vista Systems, you will also need to enable the following IIS 7.0 features (either before or after you install MapXtreme 2005):

- Internet Information Services: World Wide Web Services: Application Development Features
  - .NET Extensibility
  - ASP.NET
  - ISAPI Extensions
  - ISAPI Filters
- Internet Information Services: World Wide Web Services: Security
  - Windows Authentication
In order to run the MapXtreme web sample applications in IIS 7.0, you will also need to switch IIS 7.0 to use "Classic .NET AppPool".

If you create a new MapXtreme web application using the template through HTTP, you will need to go into IIS and explicitly set the Application Pool setting to "Classic .NET AppPool" for the new application. Otherwise you will get an ambiguous error when trying to debug in Visual Studio.

LegendControl

A new web control was added in this release of MapXtreme. The LegendControl allows you to display a legend for a given MapControl. The legend that is returned is a non-interactive image. The legend to display can be specified at design time using its LegendAlias or its index in the map’s legend list. Both thematic and cartographic legends are supported in the LegendControl. For more information on MapXtreme 2005 web controls, see Chapter 6: Web Applications, Controls, and Tools in the Developer Guide.

A new sample web application was also added to support this control. The Legend Control sample application demonstrates how to create and use a customized LegendControl based on our current web control architecture, and how to create a theme and display a legend by sending requests to the server using JavaScript without needing to refresh the whole page.

This sample application allows you to:

- perform standard operations like zoom, pan, etc.
- show or hide a legend in a LegendControl
- scroll a legend that is too large for its assigned space on the page

Performance Enhancements

See also Theme Performance and Usability Enhancements on page 18.

Seamless Raster Performance Enhancement

Seamless raster performance has been enhanced. MapXtreme now checks which handler is used for the first component table, and then uses that handler to open the rest of the component tables.

Note: Seamless grid is not supported in MapXtreme.

StyleModifier Draw Performance Improvement

Layers containing style modifiers now draw faster than in previous releases. This was accomplished by eliminating multiple copies of the same style object during the drawing loop. Instead, the contents in the style object passed to the Modify() method changes dynamically for each feature that is drawn. It is therefore important that if you need to use the style object elsewhere in your application, to make a copy of it.

Note: The Changed event for the CompositeStyles in the Style Stack passed to the FeatureStyleModifier.Modify() method is no longer fired.

Supported Operating Systems, Databases, and Browsers

Pitney Bowes MapInfo now supports MapXtreme 2005 on Windows Vista and 64-bit operating systems:

- Windows Vista Ultimate (x86, x64)\(^1\)
- Windows XP Professional x64 Edition
- Windows Server 2003 x64 Edition

\(^1\) For Windows Vista, regular administration rights are not sufficient because the installer must register the COM+ object. Vista users must right-click Setup.exe and choose ‘Run as administrator’ to obtain system privileges for the installer.
To run MapXtreme 2005 on 64-bit systems, 32-bit emulation mode is required via Microsoft's Windows-on-Windows (WoW64) technology.

The following database is also now supported:

• MapInfo SpatialWare® 4.9.2 for Microsoft SQL Server 2005 64 bit

**Note:** User accounts must have associated schemas bearing the same name. This is necessary due to behavior in Microsoft SQL Server 2005 that allows for the separation of owners and schemas for enhanced security management.

The following web browsers¹ are also supported in this release of MapXtreme 2005:

• Internet Explorer 6.0
• Internet Explorer 7.0
• Firefox 2.0
• Netscape 8.1.2

For a comprehensive discussion of system and installation requirements, see Chapter 2: Getting Started in the Developer Guide.

**Theme Performance and Usability Enhancements**

We have made several improvements in theme creation and modification that address performance and user experience issues.

• In the CreateThemeWizard, the default theme distribution method was changed from EqualCountPerRange to EqualRangeSize. EqualRangeSize is the fastest method to calculate and the dialog appears faster. Users then can modify the distribution method.

¹. The MapXtreme 2005 Learning Resources displays in Internet Explorer automatically, regardless of your default browser setting. This will not change your default browser setting.
What's New

- A new button, Recalculate Theme, was added to the theme settings control to allow the user to manually invoke a theme bin recalculation. Recalculation no longer happens automatically after a change takes place (that is, "live update" was disabled). A user must click the Recalculate Theme, Apply, or OK button, or on a new tab, after a change has been made in order for the recalculation to occur.

A check was also added to see if any of the values in the "Settings" tab were changed and if the theme needs to have its bins recomputed after:
- Tabbing to the styles or legend tab
- Clicking the Apply button
- Clicking the OK (accept) button
- Changes were also made to prevent unnecessary bin distribution re-calculations upon dialog creation. These modifications considerably improve the GUI performance.
- The wait cursor now displays while waiting for theme operations to finish, signaling to the user that something is happening and that the dialog is not frozen.
Workspace Manager Usability Enhancements

Several changes were made in this release of MapXtreme 2005 to improve the usability of Workspace Manager. See Chapter 22: Workspace Manager in the Developer Guide for a comprehensive description of this utility.

- The open folder icon in the main toolbar that represented adding tables to the current map has been changed to a green, plus sign icon. This change is intended to lessen the confusion that the folder icon caused by misleading users to believe it represented opening workspace files or applications.

Before: After:

- When you run Workspace Manager, you will now see a check box for each node in the tree. This check box duplicates the functionality of the Visible check box in the Visibility tab. You can toggle a layer’s visibility by checking either check box. The check boxes in the tree are simply a convenience; they allow you to toggle a layer with a single click. Previously you had to click once to select the layer, then click again on the Visible check box down in the tab. The new check boxes reduce the amount of mousing and clicking the user has to do to set layer visibility.
What's New

- Now in Workspace Manager's Layer Control, when you hover the mouse over the Map node (the node at the top of the Layers tree), the tooltip shows the Map Alias. This helps developers who need to know the map alias (e.g., you need to specify a map alias when setting properties on our web controls).

- We have changed the way the Options tab works in layer settings so that now MapXtreme 2005 will **not** uncheck and disable these check boxes just because the layer is not currently visible. The layer's visibility now has no impact on the Options tab. Users will now be able to see the layer's settings regardless of whether the layer is currently visible.

- A new Style tab was added to Layer Control to support cartographic enhancements for enabling translucency and anti-aliasing (see Enhanced Rendering with GDI+ Translucency and Anti-Aliasing on page 2).

- The Clear Label Modifications button was added to the Visibility tab of Label Settings. This button returns labels to their default state by removing individual labels that were manually added with the Label tool and restoring labels to their original position.

- Labels for zoom range on Visibility tab in Layer Control have changed from “Min. Zoom” and “Max. Zoom” to “Zoom is at least” and “Zoom is less than,” respectively.

  When you use a zoom range, the maximum value is exclusive—the layer is only visible if the map's zoom is less than the maximum value. So, if you set the maximum zoom value to 5000 miles, and then you zoom the map to exactly 5000 miles, the layer disappears.

- You can now right-click a FeatureLayer node in Layer Control and choose a new menu item—“Make This the Only Selectable Layer.”

- Change View Dialog—

  - Now if you cancel out of the dialog, changes are not applied; and if you enter invalid values and click OK, the dialog is not dismissed.

  - Changing the zoom units no longer resets the zoom number.

- Support is now available for style overrides of seamless raster layers. You can now access the Raster Image Style dialog from the Visibility tab when the style override is highlighted.

- The Layer Control now allows you to copy style overrides. Once you have created a style override for one layer, you can select that override (in the layer tree) and drag it onto another layer to copy the override to the other layer.

- We have fixed the behavior of the Coordinate System button in LayerControl. Now if the coordinate system is undefined, the Choose Coordinate System dialog appears with no projection pre-selected and the OK button disabled.

- We have changed the Shortcut key assigned to the “Remove Layer” context menu item from **Ctrl-R** to **Del**. You can now select a layer and press the **Del** key to delete the layer.
What’s Changed

MapXtreme 2005 provides the following modified functionality in version 6.7.

- AddColumns and BindType
- API Additions and Changes
- File Name Length
- Translucent Printing
- Trial License Watermark
- Windows Server 2003 Installation Notice

AddColumns and BindType

MapInfo.Data.AddColumns no longer performs a process that maintains a relationship between source data and bind tables when the BindType is Static or Dynamic. Under these conditions the bind process performed slowly, especially when binding large tables. Since Static and Dynamic binds do not need to maintain a relationship between the data and binds tables, the operation was omitted in favor of better performance. AddColumns will only carry out this operation when the BindType is DynamicCopy, due to the potential for the bind table to be refreshed when the source data table is updated. For further information, see Chapter 10: Working with Data in the Developer Guide.

API Additions and Changes

- A new class, MapStyleControl, was added to the MapInfo.Windows.Controls namespace. This control can be displayed on a tab in the desktop LayerControl, to allow the user to set map style and rendering options, such as anti-aliasing and translucency. (For more information, see Enhanced Rendering with GDI+ Translucency and Anti-Aliasing on page 2 and the MapXtreme 2005 v.6.7 Developer Reference).
- Three new classes, GraticuleLayer, DMS, and GridExtents, were added to the MapInfo.Mapping namespace.
  - A GraticuleLayer draws a series of longitude and latitude lines in the map window. A GraticuleLayer is similar to a set of grid lines but will change based on the map view. (For more information, see Graticule Layers on page 13 and the MapXtreme 2005 v.6.7 Developer Reference.)
  - DMS is a utility class to store degree, minute, and second information and return the corresponding decimal degrees and also a string representation of deg, min, sec.
  - GridExtents is a utility class to store a rectangle that represents the area that a grid will cover.
- The TableInfoServer.Temporary property will now throw an exception if it is set to True. The only valid setting for this type of table is False. The Temporary property is only used when creating tables. However, MapXtreme does not support creating RDB server tables.
- To increase the drawing speed of layers containing style modifiers, multiple copies of the same style object are no longer made during the drawing loop. Instead, the contents in the style object passed to the Modify() method change dynamically for each feature that is drawn. It is therefore important to make a copy of the style object if you need to use it elsewhere in your application. The Changed event for the CompositeStyles in the Style Stack passed to the FeatureStyleModifier.Modify() method is also no longer fired.

File Name Length

The length of the file title has been changed to use the MAX_PATH, which is set by the operating system (typically 256 characters). Previously the limit was 125.

Translucent Printing

Printing of translucent rasters is now supported, along with other translucent printing.

See Translucent Rasters on page 36 in the Known Issues section regarding a limitation to printing translucent rasters.
What's Changed

**Trial License Watermark**

Applications developed using the trial license now display a smaller watermark on the map, similar in size to the SDK license watermark. It also indicates the number of days remaining for the trial license.

**Windows Server 2003 Installation Notice**

The following notice was added to the MapXtreme 2005 Installation Browser to alert users that Windows Server 2003 (32-bit x86) Editions require a different .NET Framework 1.1 Service Pack 1 installation:

"The installation for .NET Framework 1.1 Service Pack 1 for Windows Server 2003 (32-bit x86) is a different installation and can be obtained via Browse CD."

The CD path for this Service Pack is \INSTALL\MSDOTNETFRAMEWORK\v1_1\SP1\WindowsServer2003.
Bug Fixes

The following topics were addressed during the development of this release of MapXtreme 2005:

- Data Access
- Desktop Applications
- Geocoding
- Layers
- Mapping
- Raster Images
- Sample Applications
- Styles
- Tables
- Themes
- Tools
- Web Applications
- Web Controls
- WMS
- Workspace Manager

Data Access

Query Statement
Two reported cases where MapXtreme failed to return correctly ordered results of a query have been fixed. MapXtreme now returns the results in the proper order from a query in which the column is specified in both the Where clause and OrderBy clause. In the case where there is an OrderBy and GroupBy in the same query, OrderBy is no longer being ignored.

Date Column
Retrieving a Date column that is null from an Oracle Spatial data table no longer throws an exception.

Case Statement
MapXtreme 2005 now returns the correct column alias when adding a table from Oracle that is a result of a query containing a Case statement.

Adding and Dropping a Column
The process of adding and dropping a column when creating a theme has been corrected.

RenditionType and RenditionColumn
MapXtreme no longer returns an error if you attempt to insert a feature into a table when the entry in the MapInfo_MapCatalog for the table has the RenditionType set to 0 and the RenditionColumn set to null.

MapXtreme will now load a remote database table containing an MI_STYLE field if the RenditionType is set to 0 and the RenditionColumn is set to null in the MapInfo_MapCatalog.

TableInfoServer.Temporary Property
The TableInfoServer.Temporary property will now throw an exception if it is set to True. The only valid setting for this type of table is False. The Temporary property is only used when creating tables. However, MapXtreme does not support creating RDB server tables.
Bug Fixes

Desktop Applications

MapXtreme Session
The issue where MapInfo.Session was not found for a desktop application has been resolved.

Desktop Application
A desktop application created from the Visual Studio 2003 Windows Application template no longer returns an EllisWrapper.netmodule error message.

Geocoding
MapXtreme now handles a geocode request containing multiples of 25 addresses without error. The method failed when multiples of the default value of 25 addresses were submitted in one request (for example, 50, 75, 100).
The MapXtreme Geocoding client now correctly sends a single geocode request to Envinsa that includes validating the URL, verifying that the service information is correct and, if provided, authenticate user name and password. Previously this required two requests.

Layers

LayerControl Options Tab
Settings in the desktop LayerControl Options tab for selectability and editability are now unaffected by the layer visibility. This means that layers that are not visible (due to Visible or Display Within Range settings in the Visibility tab) can be selectable or editable.

Mapping

DisplayTransform.ToDisplay

Legends
Legend borders now display correctly when you use points for width instead of pixels.

Raster Images
Rendering raster images on multiple CPU machines has been enhanced. If the image already exists, MapXtreme deletes it instead of overwriting it.

Sample Applications

Web.Config files for Non-Default Installations
The web.config files for MapXtreme sample applications contain the path to the default installation location of the sample data. If you have installed MapXtreme to a location other than C:\Program Files, you must edit the web.config files to match your installation location. This is also true if you have installed MapXtreme on a version other than English US (ENU) Windows XP, where the default location is typically C:\Programmer.
The sample application Readme.rtf files provide the details on how to edit the web.config files.
Sample Application Links in Learning Resources

MapXtreme has been fixed to provide only the links to the sample applications that match the sample applications you have installed on your system. If you choose not install any samples (via a custom installation), the samples list will show only a list of what MapXtreme offers, not links to the actual samples. To view the list, go to Start > All Programs > MapInfo > MapXtreme 6.7 > Learning Resources. From the Learning Resources group in the left pane of the browser, choose Sample Applications.

For all Visual Studio 2003 web and desktop links, Visual Studio .NET 2003 will launch the projects. For Visual Studio 2005, the desktop links will work the same; however, for the web projects, since there are no Visual Studio project files, the solution file will be launched. For the web controls source files, the folder containing the cs and vb projects will be launched.

Sample Applications

A variety of fixes to the sample applications were done for MapXtreme v 6.7. The following samples are now working properly.

Desktop Samples
- WfsClient
- Search (VB)
- ThemesDialog
- PieTheme
- Geocode
- Find
- RoutingandGeocoding

Web Samples
- FindSampleWeb (VB)
- all VS 2005 C# and VB samples that showed HTML validation errors
Bug Fixes

Styles

Regions with White Border
Region features no longer display with a white border when a null border is selected.

StyleModifier Draw Performance Improvement
Layers containing style modifiers now draw faster than in previous releases. This was accomplished by eliminating multiple copies of the same Style object during the drawing loop. Instead, the contents in the Style object passed to the Modify() method change dynamically for each feature that is drawn. It is therefore important to make a copy of the Style object if you need to use it elsewhere in your application. Also note that the Changed event for the CompositeStyles in the Style Stack passed to the FeatureStyleModifier.Modify() method is no longer fired.

Tables

Table Name Length
Table names and Table aliases are no longer limited to 31 characters. They can now be any length, limited by the amount of memory available. This will ease the problem of databind tables where _Selection is appended to table name.

File Name Length
The length of the file title has been changed to use the MAX_PATH, which is set by the operating system (typically 256 characters). Previously the limit was 125.

TableInfoView and Long Queries
Creating a TableInfoView using a query string longer than 512 characters is now acceptable.

TAB Files Containing Non-English Data
TAB files with indexes generated in MapInfo Professional in non-English languages are now recognized in MapXtreme 2005. These files retain the original indexes and sort order for re-opening correctly in MapInfo.

Deleting Records
The issue related to deleting records from a table that uses SpatialSchemaXY has been resolved.

Locked Table
MapXtreme no longer locks the table for editing in MapInfo Professional after features are added to the default selection and then cleared.

Oracle Views
The issue related to the Oracle error ODCIIndexStart that was thrown after invoking VIEWPORT_TRANSFORM has been resolved.

MapXtreme 2005 can now search an Oracle view that is based on a table containing a style column with a custom name. Previously MapXtreme would search only when the column was called MI_STYLE.
Bug Fixes

Seamless Raster Performance Enhancement
Seamless raster performance has been enhanced. MapXtreme now checks which handler is used for the first component table, and then uses that handler to open the rest of the component tables.

Note: Seamless grid is not supported in MapXtreme.

SpatialWare HG_CEN_X Function
The SpatialWare function HG_CEN_X now correctly returns the centroid value after the feature was edited in a TableInfoServer table. Previously when a feature was edited, by moving it to another location, the function return a null value instead of the updated centroid value.

TableInfoNative
The issue in which a table created using TableInfoNative could not be updated successfully has been resolved. The columns were being created as read only.

Themes
Creating range themes that use Equal Count bins containing null values now works correctly.
Quantile ranges now recalculate properly when you choose another quantile column. In addition, a Recalculate Theme button has been added to the ModifyTheme dialog. When you change to a different distribution method, click the button to update the calculations.

The CreateTheme dialog is now working correctly when you create an IndividualValue theme in which you check the box “Ignore Zeros” and choose columns as “Rank.” The zero rank no longer displays in the preview legend.

Tools

Microsoft vgx.dll Error
The Web tools for distance and polygon selection no longer cause MapXtreme to crash after multiple uses of the tools. This issue was attributed to a bug in Microsoft’s vgx.dll. According to Microsoft, when you view a Web page in Microsoft Internet Explorer 6.0, Internet Explorer stops responding or crashes, and you receive an access violation in vgx.dll. This problem occurs if the Web page renders vector graphics on the screen and if your computer is running Microsoft Windows XP Service Pack 2 (SP2). For more information see http://support.microsoft.com/?scid=kb;en-us;885932. A workaround for those who do not want to install the Microsoft KB885932 fix is to increase the COM+ activation time (for example, from 60000msec to 120000msec).

Tools in Firefox and Netscape
Web tools that display a line, circle or marquee box when used (for example, ZoomIn, RadiusSelect, Distance), as well as the Pan tool, now work correctly in Firefox and Netscape.

Pan Web Tool
The Pan tool no longer generates an IndexOutOfRangeException when used outside of the MapControl in a web application.

Pan/Zoom Web Tools
The left and right mouse buttons when using Pan, ZoomIn and ZoomOut web tools now work correctly. Left mouse button clicks for each tool now perform the expected interaction (pan or zoom). Right mouse button clicks display a shortcut menu only; the pan or zoom interactions will not occur.
**Bug Fixes**

**Desktop Tools**

The desktop Select tools can now be assigned to the center or right mouse buttons without issue.

The Radius/Rectangle/Polygon Select tools for desktop applications now provide a wait cursor sooner when selecting objects in a large table.

The ALT key no longer causes the polygon selection and drawing tools to stop working. Note that the Alt key has no effect on the tools, like the Shift and Ctrl keys, but caused a this problem when it was clicked by accident.

**Web Applications**

**Web Gardens**

The case where the initial page of a web application failed to load the map image has been corrected. This occurred for web applications using web controls in an application pool on a Windows Server 2003 which has its web garden set to more than one. The problem arose when the server created an image cache to hold the generated image and then sent the page to the client with the img.src pointing back to the cached image. The result was the page displayed with a red X instead of the image. MapXtreme now makes a GetMap request for a live map for every request.

**Labels and MemTables**

The case of a web application returning MapBasic style formatting instructions instead of label text from a MemTable has been fixed.

**Web Controls**

**MapAlias and Pre-Loaded Workspaces**

The issue of removing and replacing a MapControl on your web form at design time, which may result in a crash at runtime, has been resolved.

**Web Controls and HTML 4.0.1 Compliancy**

MapXtreme 2005 generates valid HTML 4.0.1 compliant code from its current Javascript-enabled web controls as well as the pre-v6.5 web controls when using Visual Studio .NET 2003 and Visual Studio 2005. There remain two instances in Visual Studio 2005 that will generate validation errors, however, they do not impact the functionality of the web controls.

- There is no attribute "BACKGROUND"
- The "value of attribute "ID" invalid. "_" cannot start a name.

In the first case, BACKGROUND refers to the decorative MapInfo header at the top of the page (<td background="images/header_bg.gif">). Simply remove this reference.

In the second case, the syntax type="hidden" name = "_VIEWSTATE" id="__VIEWSTATE" is generated by Microsoft ASP.NET 2.0. A workaround is to modify the page’s DOCTYPE to specify XHTML 1.0, as shown below:

```html
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" "http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd">
```

**MapControl Height and Width Settings**

The display problem caused by setting the width and height properties for a web MapControl using percentage values has been fixed.
**LayerControl Visibility Behavior**

The web LayerControl now exhibits correct behavior when checking or clearing visibility check boxes for themes or style overrides. If the LayerControl contains multiple themes and/or style overrides, checking the box for one layer, no longer checks the boxes for all of them.

**VB Source Code Now Compiles in Visual Studio 2005**

The VB source code for the new Javascript-enabled web controls now compiles without error in Visual Studio 2005. An unnecessary assemblyinfo.vb was removed from the project.

**WMS**

MapXtreme requires full URLs in the web.config files to a WMS server when requesting its capabilities (dtdUrlCapabilities and dtdUrlException). If no URLs are provided for these variables, MapXtreme will return a default URL in the XML output (http://schemas.opengis.net). By supplying a full URL in the web.config file, this removes issues relating to accessing a web application behind a firewall or proxy server. If a relative URL or an incorrect URL is used, the WMS server will still generate the XML with the provided URL, but the XML output will not validate if the requesting client is using a validating XML parser.

**Workspace Manager**

Editing nodes in Workspace Manager no longer causes problems when editing two layers. Nodes in each layer can now be moved without affecting the nodes in another layer.

Opening a .TAB file with a long file name in Workspace Manager no longer causes an error.
Known Issues

The issues that follow are those identified since the previous release of this product. They are either currently under investigation or in active development seeking a resolution.

- 64-bit Issue
- ADO.NET Serialization
- Data Access
- Enhanced Rendering
- Graticules
- LayerControl
- Labels
- Legends
- Licensing
- Mapping
- Performance Issues Related to Large Tables
- Printing
- Raster Images
- Sample Applications
- Sample Code
- Serialization
- Styles
- Tables
- Tools
- Visual Studio 2005
- Web Applications
- Web Controls
- WMS/WFS
- Workspace Manager
- Miscellaneous Issues

64-bit Issue

On a 64-bit machine, you may get a BadImageFormatException when trying to run a MapXtreme 2005 desktop application. Since MapXtreme runs in 32-bit emulation mode on 64-bit systems (WoW64), you must assign the application you are building in Visual Studio 2005 to use the Platform Target x86. In the project properties, click on the Build tab and choose x86 for the Platform Target.

Switching Between .NET Framework 1.1 and 2.0 on 64-bit Windows Systems

MapXtreme 2005 is a 32-bit application that runs on 64-bit systems under the .NET Framework 1.1 natively or the .NET Framework 2.0 using Microsoft's Wow64 technology (see Supported Operating Systems, Databases, and Browsers on page 17).

The following URL explains how to switch between the 1.1 and 2.0 Frameworks on 64-bit systems: http://support.microsoft.com/kb/894435. The key points are included below:

Using MapXtreme 2005 on the .NET Framework 1.1 on a 64-bit System

1. Execute the following script:
   cscript %SYSTEMDRIVE%\inetpub\adminscripts\adsutil.vbs SET W3SVC/AppPools/Enable32bitAppOnWin64 1

2. Execute the following command:
   %SYSTEMROOT%\Microsoft.NET\Framework\v1.1.4322\aspnet_regiis.exe -i
3. Under Web service extensions in IIS Manager, ensure ASP.NET version 1.1.4322 is set to Allowed.

Using MapXtreme 2005 on the .NET Framework v2.0 on 64-bit System)

1. Execute the following script:
   cscript %SYSTEMDRIVE%\inetpub\adminscripts\adsutil.vbs SET W3SVC/AppPools/Enable32bitAppOnWin64 1

2. Execute the following command:
   %SYSTEMROOT%\Microsoft.NET\Framework\v2.0.50727\aspnet_regiis.exe -i

3. Under Web service extensions in IIS Manager, ensure ASP.NET version 2.0.50727 (32-bit) is set to Allowed.

ADO.NET Serialization

Because of situations in which we cannot reliably re-establish references to a shared DataTable instance (resulting in disjoint copies), the automatic serialization of TableInfoAdoNet based tables is currently unsupported. Chapter 10 in the Developer Guide outlines a manual procedure that can be used until this capability can be properly and reliably supported. Please check here in the Release Notes for the latest information and updates pertaining to that feature.

Data Access

Update Query for MS Access

Executing an update query on a MS Access table fails to insert style and object. For example:

```
insert into custpointswest (Obj, MI_Style) values (newobject, newstyle))
```

However, if you only insert the Obj field, the query works, as below:

```
insert into custpointswest (Obj) values (MI_Point(-121.331658,38.546608,'EPSG:4326'))
```

MS Access Failed Connections

MapXtreme Web applications that access Microsoft Access databases may experience failed connection attempts. This is due to a limitation in Microsoft's Jet database engine when used in a high-stress, 24 x7 server environment. The Jet database engine, the engine behind MS Access, is limited to 64 concurrent connections. This includes the number of tables across all threads. In high-stress web environments, the actual number of successful concurrent connections may be less. For more information, see the following Microsoft technical publication:

http://support.microsoft.com/default.aspx?scid=kb;EN-US;q222135

Microsoft recommends using MS SQL Server with IIS for web applications that require absolute data integrity or high user concurrency.

Catalog.Search Leaks

Catalog.Search using SearchResultProcessor leaks ResultSet tables in the Catalog (that is, extra ResultSetTables remain in the Catalog). The user also does not have the ability to determine which ResultSet table was created.

Insert Data Crashes

Bulk inserting a large number of records from one table into another using an INSERT INTO... SELECT... statement may cause the machine to run out of memory and crash. The inner SELECT results are being fully loaded into an in-memory temporary table thereby causing this large data set to possibly exhaust available memory. Users should consider replacing the INSERT INTO...SELECT... statement with a loop which iterates over the SELECT results and executes an insert for each record.
Known Issues

Error Creating Index During SQL Query

The composition of values from the fields referenced in a GROUP BY clause are used to create key values for a temporary table created internally during statement execution. An index is created for the key value column in the temporary table, and this index is currently limited to values with a maximum length of 254. To avoid index creation errors, please ensure that composite keys will not exceed this maximum length (that is, try to avoid long string columns in the GROUP BY clause).

Enhanced Rendering

Translucency Slider Controls

The translucency slider controls in all the style dialogs have no affect unless enhanced rendering (translucency) is enabled. When enhanced rendering is disabled, the translucency slider controls in the styles dialogs are still enabled. Users must be aware that although they can use the translucency trackbar, translucency effects will only be applied if Enable Translucency is enabled (see Enhanced Rendering with GDI+ Translucency and Anti-Aliasing on page 2 of the What’s New section for more information on enabling translucency).

Color Picker Dialog

The color picker dialog does not have support for translucency. This dialog is used by themes to pick the inflection color in a ranged theme and the dot color for dot density themes. It does not use the color picker control used by most styles dialogs.

Remote Desktop Issue

The quality of images in Enhanced Rendering mode is sometimes compromised when using Remote Desktop to run MapXtreme 2005. The white parts of the map may draw with a grey tint when you pan the map.
**Known Issues**

**White Borders Caused by Anti-Aliasing**

Turning on anti-aliasing causes layers with straight edges to be drawn with white lines. If you have a table that contains a series of rectangular features with the same boundaries and anti-aliasing is enabled, you see a light border around each feature, as pictured below:

In these instances you either should disable anti-aliasing or select borders with the same color as the feature.

**Graticules**

If a graticule is the first item inserted into a workspace, nothing appears and subsequent layers cannot be seen. To view the map and the grid lines, you must right-click the root node that corresponds to the map and select View Entire Map.

**LayerControl**

**Edit Handles**

Edit handles aren't displayed or hidden properly when using LayerHelper class to make a layer editable.

Edit handles also do not display properly when you select features in a layer, and then set the layer to be editable using the desktop LayerControl. The problem goes away the first time you redraw the map. Edit handles behave correctly as you select and deselect features.

**Select Tool**

The Select tool does not behave correctly in LayerControl when Allow Node Editing is turned on.
Known Issues

Labels

The rotation handles that display for labels and legacy text that are selected do not operate. Additionally, the anchor point position cannot be changed.

Label visible range is not inclusive at MaxZoom in some situations. The visible zoom level varies due to the coordinate system, possibly due to rounding calculations.

LegendControl

The web version of the LegendControl will not work properly when put on an ASP template. If the only thing on the webform is a MapControl and LegendControl, the LegendControl base bitmap will not show (that is, a red X appears). If you put a tool on the webform before placing the LegendControl, then the LegendControl will work.

Legends

BarTheme Legend

The BarTheme legend does not update to show scale after the map zoom level is changed. In place of the scale, a “Not drawn to scale” message displays.

Legend Row Visibility

The LegendFrame.Rows.Visible property, when set to ‘false’, does not turn off the legend row as expected.

Duplicate Legends

Re-opening a workspace with a theme and saving it creates two legends in the workspace.

Appended Custom Legends

Saving a map and an appended custom legend to a workspace results in an error.

Licensing

The licensing in MapXtreme 2005 is unable to determine if an application is running as a desktop or web application when deployed as a Web Service. For web applications use a desktop runtime license along with your web runtime license.

Mapping

Exporting to EMF

Exporting to EMF and viewing the EMF file in Microsoft Word displays more of the map than was originally exported.

Panning

When panning a map that uses a scale range for visibility, white patches display over the map.

Map Center Point Incorrect After Pan and Zoom

ASP.NET session state management problems can occur when using StateServer and SqlServer under .NET 2.0 framework. When performing a zoom or pan operation on the map, the new center point of the map image is offset incorrectly. This problem was encountered only in Visual Studio 2005 using the 2.0 Framework.
Known Issues

Exporting to a Higher Resolution
Exporting a map with labels to a higher resolution increases the size of the labels.

Labeling Smoothed Polylines
MapXtreme crashes when you attempt to label a polyline that has smooth bit turned on (from a MapInfo Professional table).

Opening Many Windows
Opening many map windows (40 or more) causes the map to draw incorrectly

Performance Issues Related to Large Tables

AddColumns
MapXtreme 2005’s performance can be very slow when you are adding columns to tables with more than 200,000 records. We recommend that you create the columns collection yourself (instead of passing in NULL). Include the geometry column only if you need it. Do not index the temporary columns unless you need to. See also AddColumns and BindType on page 22.

Inserting records into a TableInfoServer table using MICommand takes a long time for a large number of records.

Printing

Adornment Positioning
Adornments are not positioned correctly when printing.

Translucent Rasters
There is a limitation with printing translucent rasters. EnableTranslucency must be enabled to print translucent rasters; however, this is not required for screen display or exporting.

Print Preview Unhandled Exception
Print Preview throws an unhandled exception in Workspace Manager with HP LaserJet printers and 2.0 Framework.

Note: The Print Preview exception has a Continue and Quit button. If you click the Quit button, Workspace Manager closes. If you click Continue, Workspace Manager opens successfully. However, you will not be able to print successfully to this printer until you restart Workspace Manager.

FeatureStyleModifier
When attempting to print or export a map after applying a FeatureStyleModifier, the resulting image does not display any of the modifications. It appears that when the printing or exporting methods create a new map, the modify method receives a values parameter that is null; therefore the code that modifies the features does not run.

Raster Images

ESRI Grid and ERDAS IMAGINE Files
MapXtreme 2005 is unable to open ESRI Grid or ERDAS IMAGINE (.IMG) raster files in Workspace Manager.
Distortion in Side-by-Side Images

When attempting to generate seamless side-by-side images of a map, a slight distortion in the resulting images occurs if a raster image is added, even when the map’s projection matches that of the raster. A side effect of adding a raster image is that it always determines the current coordsys to use. It also affects where the standard parallel is set which slightly skews the display. To eliminate the distortion, simply regenerate the second image.

Sample Applications

Netscape and Firefox

Some of the sample web applications created for Visual Studio 2005 do not render correctly when viewed in Netscape or Firefox browsers. The Pan tool is also unpredictable. This applies to the DataAccess, LegendControl, CustomTools, HelloWorld and Thematics web samples. These samples render and perform properly when viewed in Internet Explorer.

ThematicsWeb

Thematics sample web application on Netscape/Firefox: In order for this sample application to render properly and for the pan tool to work correctly, the following changes are needed in the webform1.aspx file:

• In the parent element <td> of the <LayerControl> element, change the style as follows to add the display:block:
  <td style="display:block;position:relative">
• Change the LayerControl style positioning from absolute to relative (i.e. position: relative).

Tools Sample in German/French Locale

In Visual Studio 2003 on Windows XP for German and French locales, the Tools sample web application displays incorrectly. At runtime the sample draws correctly.

World.MWS

In the HelloWorldWeb sample application, the ocean layer in the world.mws map is corrupt (many dots appear in the ocean). This happens when you have an adornment attached to map.

Sample Code

The code snippet for the MapInfo.Engine.Angles class in the Developer Reference incorrectly shows the conversion from degrees to radians. The bold line below is the correct syntax.

```vbnet
Public Shared Sub MapInfo_Engine_Angles()
    Dim angleR As Double = Math.PI / 2.0
    Dim angleD As Double = Angles.RadiansToDegrees(angleR)

    If (89.0 < angleD < 91.0) Then
        ' 90 degrees = pi/2 radians
    End If

    Dim convertedR As Double = Angles.DegreesToRadians(90.0)

    'convertedR is pi/2
End Sub
```
Known Issues

Serialization

You cannot deserialize an ASCII PointRef table if the reference table is closed. You must first deserialize the pointRef table and then close the reference table.

When using ranged themes, do not clear the theme before deserializing it. This will result in differences in the theme properties between the serialized and deserialized theme.

Styles

The black halo for a Text style is not displaying correctly. This is observable in the TextStyleDlg and StyleSampleBitmapButton object (button on the Style tab). As a workaround, choose a very dark gray as the halo instead of black.

The Symbol style for a Graduated Symbol theme is not properly reflected in the Layer Control. Graduated Symbols appear correctly on the map but are represented by a different symbol in the Layer Control.

Disposing CompositeStyles

CompositeStyles do not contain a way to free the resources used, causing memory leaks under some conditions. In the following code example, to avoid a memory leak, set the CompositeStyle to null.

```csharp
private MapInfo.Styles.AreaStyle _style = new MapInfo.Styles.AreaStyle();
for (int i = 0; i < 1000000; i++)
{
    MapInfo.Styles.CompositeStyle cs = new MapInfo.Styles.CompositeStyle(_style);
}
    cs.AreaStyle=null;
```

Tables

WriteTabFile()

TableInfoView.WriteTabFile() doesn't write out the CharSet property, resulting in the default value (Latin1) being used.

Alias

You cannot change the alias of a FeatureCollection returned from a Search. The exception string and online documentation does not include this information.

SpatialSchemaXY

Update operations on a MapXtreme Catalog for a Microsoft Access database fail when a SpatialSchema object is used.

Vertical Mapper GRD Files

MapXtreme 2005 locks a Vertical Mapper GRD file during use, preventing further operations on the file outside of MapXtreme 2005. For example, the file cannot be edited with the VM SDK method vmWriteGRDRow nor can it be deleted from a user’s system through Windows Explorer.
Known Issues

**ASCII and Other File-Based Table Formats**

MapXtreme is unable to open ASCII files that have non-TXT file extensions. The DataPath property on TableInfoAscii cannot reliably determine where the file is located when the extension is other than .TXT.

MapXtreme is unable to open supported file-based formats when the related .TAB file is located in a different directory from the base file.

**Tools**

**InfoTips**

InfoTips do not display when you hover over a feature on the map with the Select tool. The InfoTips will display if you select the feature.

**Rectangle Select Tool**

The RectangleSelect tool in MapXtreme 2005 may draw slower than expected when the map contains Oracle Spatial layers. To avoid this issue, clear the Show InfoTips check box for the layer(s) in Workspace Manager.

**Firefox and Netscape**

Tools do not work properly in Firefox or Netscape when creating a new web application from the ASP.NET web application template in Visual Studio 2003 or Visual Studio 2005.

**Visual Studio 2005**

**ASP.NET 2.0**

If you create a web application in Visual Studio 2005, you must manually switch the virtual directory to use ASP.NET 2.0, or the page will not load.

To switch the virtual directory to run ASP.NET 2.0, in IIS Manager, navigate to your virtual directory and right click to display the Properties dialog. In the ASP.NET Version drop-down list, choose the 2.0 tag.

**MapForm Designer**

The MapForm designer in Visual Studio 2005 throws errors when you load a map into a MapControl, then close the map before rebuilding the application. This happening regardless of the type of template (MapXtreme or Windows) or programming language (C# or VB) you use. As workaround, be sure to rebuild your application after loading a map.

**Web Setup Project**

If you create your own deployment for a web application in Visual Studio 2005, you will need to add the MSMs manually. The web setup project does not detect the assemblies that are referenced within Web.config; thus the assemblies (and the corresponding MSMs) are not detected as dependencies.

To add the MSMs manually, right-click on your web setup project and choose Add: Merge Module. Select MapInfoCoreEngine_6.x, MapInfoMXTConfig_6.x, MapInfoWeb_6.x and any other MSMs you need.

**Setup Project with Side-by-Side Installations**

If you have a side by side installation (e.g., v6.6 and v6.7) on the same machine and you create a setup project for a MapXtreme 2005 v6.7 project within Microsoft Visual Studio 2005, the earlier versions of the MapInfoCoreEngine[intl] and MapinfomxtConfig MSMs will also be detected as dependencies.
Known Issues

You should exclude the earlier versions of the MSMs to create an efficient setup project. Right click on the earlier version and choose Exclude.

Note: The detection of previous versions of the MSMs is not the behavior of Visual Studio 2003, only Visual Studio 2005.

Web Applications

Web Template Web.config for Non-English Operating Systems
On some non-English operating systems, the web.config file that is generated by the MapXtreme 2005 ASP.NET web template does not contain the correct path to the world.mws file. The correct path is C:\Programmer\MapInfo\MapXtreme\6.6\Samples\Data\World.mws.

Pure Virtual Function Error
In some situations when closing down a web application, you may see a Pure Virtual Function error. For example, when you are restarting IIS or changing the Web Garden setting this error may occur. You may also experience this in Visual Studio after making a change to your application and then rebuilding. If this error occurs you can click OK and continue without any problems. This error is the result of timing issues involved with correctly unloading the MapXtreme session when the worker process exits.

Browser Back Button and pre-v6.5 Web Controls
In a web application, if you zoom in on one area of a map, click the Back button, and zoom in on another area of the map, the previous zoom view displays. The Forward and Back browser buttons are disabled. This applies to the pre-v6.5 web controls only.

Pre-v6.5 web InfoTool
The pre-v6.5 web InfoTool selects features incorrectly and inconsistently. The expected behavior is that the tool selects objects that intersect the select point within a certain pixel tolerance. Currently it selects objects that have a minimum bounding rectangle (MBR) that enclose the clicked point. These MBRs may have larger or smaller tolerances. This behavior does not exist in the JavaScript-enabled Web MapControl.

Web Controls

MapAlias Is Required at Design Time
You must set a MapAlias value every time you add a MapControl to a WebForm. If the MapAlias is not set at design time, your application will not run properly, resulting in a crash. Further, if you change the MapAlias value at runtime, an error will result from the application looking for the original MapAlias.

The MapXtreme 2005 web template and samples provide a default MapAlias called “Map1”.

MapAlias and Session Management
Changing to a different MapAlias for a MapControl at runtime restores incorrect session values. The default session management settings in MapXtreme 2005’s project templates and sample applications only store changes to the HTTP session, rather than the entire session. As stated in the above known issue, the MapAlias is the key to tying the changes to the correct session. If the MapAlias is changed at runtime, the session will return state that was for the previous MapAlias.
Known Issues

PointSelectionTool
The web PointSelectionTool cursor hotspot is not at the expected location (top of finger). This makes it difficult to click precisely on an object.

Pixel Tolerance
Setting the PointSelection tool's PixelTolerance property to 0 (zero) will result in a crash at runtime. The exception that is thrown states "Specified argument was out of the range of valid values." Use a positive integer when setting PixelTolerance.

LayerControl
When adding a Layer from temporary table to the map, the LayerControl will crash. This occurs when the <appsettings> in the web.config file for the application are set like the text below:

```xml
<add key="MapInfo.Engine.Session.Pooled" value="false" />
<add key="MapInfo.Engine.Session.State" value="HttpSessionState" />
<sessionState mode="StateServer" stateConnectionString="tcpip=xxx.x.x.x:xxxx" sqlConnectionString="data source=xxx.x.x.x;userid=sa;password=" cookieless="false" timeout="20" />
```

Note that these settings are not the recommended settings for MapXtreme 2005. The project templates and samples use pooling, manual Session.State and InProc sessionState mode. This gives you more control over what is saved for each HTTP session. See Chapters 5 and 6 in the MapXtreme 2005 Developer Guide for information on best practices for web applications and managing state.

WMS/WFS
Workspace Manager errors when you select Map > View Entire Layer for a WMS Table version 750.

Workspace Manager
Changed values are not included when a workspace is saved. For example, if you change one of the zoom values on the Visibility tab then immediately click Save, the change is not preserved upon exiting Workspace Manager and reopening the workspace. However, if you click away from the control containing the changed value (that is, lose focus) prior to clicking Save, the changed value is saved.

Miscellaneous Issues

MessageBox
Putting a message box in a window (form) constructor prevents marquee zoom in and zoom out tools from working. To avoid this situation, put the MessageBox call in the form's Load event handler method.
Documentation Topics

The following items are topics that are unclearly documented or missing from the MapXtreme Documentation set (Developer Guide and Developer Reference).

MapXtreme Web Application Template
The MapXtreme Visual Studio 2005 template opens to the Source view that shows the HTML for webform1.aspx. This behavior is dictated by a user preference in Visual Studio under the Tools > Options menu in which the user can choose between Source View and Design View. MapXtreme templates honor the user preference over the built in preference to display in Design View.

Special Characters in Field Names
MapXtreme does not support special characters in field names unless it meets the following criteria:

The following symbols are valid in a field name only if they exist at the end of the identifier and they are not the only character in the field name.

- $  
- @  
- %  
- !  
- &

To verify that a field name is valid, MapXtreme now checks the name against a table of invalid characters. Anything not found in the table, is acceptable for a field name. That means fields names may contain alpha and numeric characters a-z, A-Z and 0-9.

TableInfoServer.Temporary Property
In the MapXtreme Developer Reference, it incorrectly states that you can set MapInfo.Data.TableInfoServer.Temporary to true. For this table type, creating a temporary table is not supported. TableInfoServer now throws an exception if Temporary is set to true.